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Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 

accompanying such products and services. Nothing herein should be construed as constituting an additional 

warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 

with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 

Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 

commercial license. 

Copyright Notices 

© Copyright 1993-2011 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Microsoft®, Windows®, Windows Server®, Windows® XP, and Windows® 7 are U.S. registered trademarks 

of Microsoft Corporation.  

Windows Vista
TM

 is either a registered trademark or trademark of Microsoft Corporation in the United 

States and/or other countries. 

Java™ is a US trademark of Oracle Corporation. 

UNIX® is a registered trademark of The Open Group. 

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated. 

Pentium® is a registered trademark of Intel Corporation or its subsidiaries in the United States and other 

countries. 

This product includes software developed by the Apache Software Foundation (http://www.apache.org/). 

 

For additional licensing information about third party and open source software, see the 

open_source_and_third_party_licenses.pdf file in the bin\documentation folder on the DDM 

Inventory 9.30 distribution media. 
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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 

valued support customer, you can benefit by using the support site to: 

 Search for knowledge documents of interest 

 Submit and track support cases and enhancement requests 

 Download software patches 

 Manage support contracts 

 Look up HP support contacts 

 Review information about available services 

 Enter into discussions with other software customers 

 Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 

an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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HP Discovery and Dependency Mapping 

Inventory 

Release Notes 

Software version: 9.30 / February 2011 

This document provides an overview of the changes made to Discovery and Dependency Mapping Inventory 

(DDM Inventory) for version 9.30. It contains important information not included in the manuals or in the 

online help. 

Conventions Used in this Document  

In This Version 

New Features 

 Software Recognition 

— Oracle recognition 

— Software identification tags 

— New SAI structure 

 Store and Forward Server 

 Scanner Scheduler 

 SSH key authentication for UNIX agentless scanning 

 Updated Web UI 

Compatibility Notes 

Scanner Support Information 

Obsolete Features 

Documentation Updates 

Installation Notes 

Enhancements and Fixes 

Known Problems, Limitations, and Workarounds 
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Conventions Used in this Document  

By default, when you install the DDM Inventory Server software, all the components will be in one of the 

locations specified in the following table. The placeholders are used to represent the DDM Inventory 

program and data folders referenced in this document: 

Folder Placeholder Platform Default Location 

Program 

Files 

<InstallDir> Windows  

Server 2008 x64 

C:\Program Files (x86)\Hewlett-

Packard\DDMI\9.30 

All others C:\Program Files\Hewlett-Packard\DDMI\9.30 

Data 

Files 

<DataDir> Windows  

Server 2008 

C:\ProgramData\Hewlett-Packard\DDMI 

Windows Server 

2003 

C:\Documents and Settings\All 

Users\Application Data\Hewlett-Packard\DDMI 

You can customize both of these locations when you install the DDM Inventory Server. 
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In This Version 

Introduction 

These release notes are for DDM Inventory 9.30. This new version of the product is the upgrade path for 

users of DDM Inventory 7.6x and 7.7x. Please note that DDM Inventory 9.30 is a minor upgrade. The change 

in product number from version 7.70 to 9.30 was done to align DDM Inventory with other HP Software 

products that are now on version 9.x. 

If you want to see what features have been introduced in previous versions of DDM Inventory (formerly 

called Enterprise Discovery), you can read the Release Notes for those versions available on your installation 

CD under bin\documentation.  

License Schema 

Each DDM Inventory server is limited to holding a maximum of 50,000 inventoried devices, 60,000 

discovered devices, or 150,000 discovered network ports (whichever occurs first). A DDM Inventory 

Aggregator can support up to 50 servers and up to 500,000 devices. 

Updated Third-Party Components  

 Strawberry Perl 5.12.0 

 Java Runtime Environment (JRE) 1.6.0_20 
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New Features  

DDM Inventory 9.30 provides several new features to extend existing functionality and provide users with 

new capabilities. The following section describes these features. 

Software Recognition 

Oracle recognition 

DDM Inventory 9.30 introduces new Oracle software recognition capabilities. These capabilities provide a 

more reliable mechanism for identifying Oracle software installations across all platforms. In this version, 

instead of relying on static file-based recognition, DDM Inventory extracts Oracle software information from 

the Oracle Universal Installer.  

For more detailed information, refer to the “Application Recognition” chapter in the Scan Data Analysis 

Guide. 

Software identification tags 

DDM Inventory 9.30 has been enabled to consume ISO/IEC 19770-2 software identification tag information. 

ISO/IEC 19770-2 is a new industry standard for software identification. A software identification tag is an 

XML file containing identification and management information about a software product. The tag is 

installed onto a computing device together with the software product, and uniquely identifies the software, 

providing data for software inventory and asset management.  

With the introduction of industry-standard software identification tags, it becomes possible to automate the 

processes of gathering software inventory data for use in reporting and in other initiatives such as managing 

software entitlement compliance. As these tags gain wider acceptance, they will allow for a more complete 

and more reliable software inventory across the various vendors and operating systems. 

For more detailed information, refer to the “Software Identification Tags” chapter in the Scan Data Analysis 

Guide. 

New SAI structure 

This release introduces a new structure for Software Application Index files. Specifically, the Master SAI file 

has been split into two files: Master SAI and Legacy SAI.  

The purpose of this change is to provide additional clarity to customers, HP technical support, and the HP 

R&D organization regarding the maintenance of specific SAI entries. This change will allow HP to 

periodically review the contents of its SAI files and perform a cleanup to ensure continued focus on work 

that benefits the majority of our customers.  Some of the reasons for the changes may be: the age of specific 

entries; the market share (popularity) of the application, and the replacement of file-based entries with rule-

based entries (not currently employed due to support requirements for pre-7.6x releases). 

On a new installation of DDM Inventory 9.30, Legacy.zsai is in the default configuration. In an upgrade 

scenario, Master.zsai will be converted to Master.zsai and Legacy.zsai. For more detailed information, refer 

to the “Upgrade and Migration Scenarios” chapter in the Installation and Initial Setup Guide. 

The entries in the Legacy SAI file will not be maintained by HP; they are provided for historical reasons.  

Customers may request that HP provide an update for an entry located in the Legacy SAI file.  However, 

customers should not expect any of these entries to be updated without a direct customer request. You can 
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request a new entry by contacting technical support. HP has an established process for handling these 

requests. When some new entries are added to the SAI, they may be placed in the Legacy SAI file.  If we see 

multiple requests for different versions of the application, we will periodically move entries from Legacy SAI 

to Master SAI. 

HP will continue to monitor titles present in the Master SAI file and update them proactively whenever 

possible. However, not all software titles are available to HP (for example, due to competitive reasons), so 

customer cooperation may be needed in some cases before updates are made to specific SAI entries. 

Store and Forward Server 

The Store and Forward server is a standalone component in DDM Inventory 9.30 that allows for more 

flexible inventory collection capabilities when running the scanners in the Manual Deployment mode. It is 

designed to facilitate the traversal of scan files through multiple firewalls until the scan files reach the DDM 

Inventory server.  

 

Normally in the Manual Deployment mode, the Incoming directory of the XML Enricher is shared either via 

a network file share (Windows), HTTP (done out of the box) or FTP. The scanners are configured to save 

their off-site scan file to that UNC location or URL. In order for this to work, the managed device on which 

the scanners are running ought to be able to connect to the specified UNC path/URL directly. Unfortunately, 

in more complex deployment scenarios, this may not always be possible due to segmentation of the network, 

or firewall restrictions. The chain of Store and Forward servers allows you to build an infrastructure that 

can move scan files through multiple firewalls until they finally reach the DDM Inventory server for 

processing.  

 

The Store and Forward server works over one configurable TCP port and uses HTTP or HTTPS as the 

underlying network transport mechanism. It supports the forwarding of data to multiple locations, 

bandwidth throttling, and resumed file transfer between Store and Forward servers.  

For more detailed information, refer to the Store and Forward Server Guide. 

Scanner Scheduler 

The Scanner Scheduler is a standalone component in DDM Inventory 9.30 that allows for more flexible 

scanner deployment scenarios in the Manual Deployment mode. It implements the scanner scheduling 

capabilities in cases where the DDM Inventory server is not able to connect to the device directly. The 

Scanner Scheduler allows the scanner scheduling to happen locally on the managed computer itself, rather 

than being controlled from the DDM Inventory server. The Scanner Scheduler can be used on its own or in 

combination with a chain of the DDM Inventory Store and Forward servers that facilitates the transfer of 

the scan files through multiple firewalls.  

 

The Scanner Scheduler runs as a service (Windows) or as a detached process (UNIX) on a client computer 

and, according to its configuration parameters, periodically runs the DDM Inventory Scanner. The Scanner 

has the ability to save the scan file off-site to a remote location, including a Store and Forward server or the 

DDM Inventory server itself. The Scanner Scheduler can also periodically update its configuration by 

retrieving a new version of the configuration located in its config.ini file from a remote location. The Scanner 

Scheduler supports the same platforms as the DDM Inventory Scanner.  

For more detailed information, refer to the Scanner Scheduler Guide. 
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SSH key authentication for UNIX agentless scanning 

In DDM Inventory 9.30, administrators can configure the agentless inventory process to log in to a remote 

device with a username and password, or log in by using key-based authentication. SSH credentials can be 

used to create a Secure Shell connection to UNIX, Linux, and Mac OS X devices. If you choose key-based 

authentication, you must upload a private key file to be used in the SSH connection. Additionally, you may 

encrypt the key file with a passphrase. 

For more detailed information, refer to the “Setting Up Agents and Scanners” chapter in the Installation and 

Initial Setup Guide. 

Updated Web UI 

To give users a more convenient and richer browsing experience, the DDM Inventory web UI has been 

updated and improved. Specifically, the Common Web Client has been improved, and tasks such as 

navigation have become easier and more intuitive.  
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Compatibility Notes  

Reports Database Changes 

Additions 

 Added table Aggregate.hwOSSoftwareIdTags. 

 Added column hwsmbiosConfiguredMemoryClockSpeedMHz to table 

Aggregate.hwsmbiosMemoryDevice. 

 Added column hwsmbiosCoolingDeviceDescription to table 

Aggregate.hwsmbiosCoolingDevice. 

 Added column hwsmbiosIPMIDeviceInformationInterruptInfo, 

hwsmbiosIPMIDeviceInformationRegisterSpacing, and 

hwsmbiosIPMIDeviceInformationInterruptNumber to table 

Aggregate.hwsmbiosIPMIDeviceInformation. 
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Scanner Support Information  

All Scanners and Agents supported in the 7.70 release of this product are supported in the 9.30 release. 

Refer to the Compatibility Matrix for the 9.30 release of interest for the list of all supported platforms. 

 
When an install is upgraded from a previous release, it is possible to use the Scanners and 

Agents from previous releases if you explicitly specify the Scanner and Agent versions using the 

configuration options on the following pages: 

Administration > System Configuration > Scanner deployment 

Administration > System Configuration > Agent communication 
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Obsolete Features  

Windows Vista Readiness reports 

The Windows Vista Readiness reports were removed from DDM Inventory 9.30. 
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Documentation Updates 

The first page of this release notes document contains the following identifying information: 

 Version number, which indicates the software version.  

 Publish date, which changes each time the document is updated.  

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to:  

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 

Contact your HP sales representative for details. 

NOTE: To view files in PDF format (*.pdf), Adobe Acrobat Reader must be installed on your system. To 

download Adobe Acrobat Reader, go to the following web site: 

http://www.adobe.com/ 

The following PDF documents are available in the DDM Inventory Web UI: 

 Planning Guide  

 Installation and Initial Setup Guide 

 Configuration and Customization Guide 

 Network Data Analysis Guide 

 Scan Data Analysis Guide 

 Reference Guide 

http://h20230.www2.hp.com/selfsolve/manuals
http://h20229.www2.hp.com/passport-registration.html
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Installation Notes 

Instructions for installing DDM Inventory are documented in the Installation and Initial Setup Guide 

provided in Adobe Acrobat (.pdf) format.  

 
Perl, MySQL, Tomcat and Apache are standard parts of the DDM Inventory, included with each 

server installation. If you have these components installed already, make sure to remove them 

before installing DDM Inventory. You may NOT substitute any other technologies in place of the 

standard installation. 

Software and Hardware Requirements  

The following sections detail the requirements for the DDM Inventory server and client components, 

respectively. 

Client Requirements 

The DDM Inventory client components (Analysis Workbench, SAI Editor, System Panel, and Viewer) have 

the following requirements: 

Resource Requirement 

Operating System Windows XP/Vista, Windows Server 2003/2008, Windows 7 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 

Environment 

See Help > Compatibility Matrix in the DDM Inventory GUI for 

versioning information 

Server Requirements 

The DDM Inventory Server can be installed on 32-bit versions of Windows Server 2003 (SP1, SP2), Windows 

2003 R2, or Windows Server 2008 (SP1), and the 64-bit version of Windows Server 2008 (SP1 or SP2), or 

Windows 2008 R2. For information about all supported platforms, refer to the Compatibility Matrix. 

Recommended Server Platforms 

For large servers (up to 50,000 devices), the following is recommended: 

 HP Proliant Model: DL380 G7  

 CPU: 8 Core (Intel® Xeon® 5600 series)  

 Memory: 8 GB 

 Disk: See the Storage Requirements section below. 

For medium servers (up to 15,000 devices), the following is recommended: 

 HP Proliant Model:  DL380 G7  
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 CPU: 4 Core(Intel® Xeon® 5600 series) 

 Memory: 6 GB 

 Disk: See the Storage Requirements section below. 

Sample Server Scenarios 

The following table details a variety of scenarios that can help you estimate your server hardware 

requirements. The Disk value is for your data directory. You will require at least 6GB for the DDM 

Inventory installation. 

The information presented below is for illustrative purposes only.  Proper sizing of the DDM Inventory 

server(s) may require assistance from a qualified architect.  HP recommends utilizing experienced resources 

to assist in architecture and the initial deployment of DDM Inventory.  Among the factors that need to be 

considered and which will impact the infrastructure architecture are the following: 

 Number of and distribution of devices (such as if slow WAN links exist between large population groups) 

 Type of and amount of information collected (examples below demonstrate the impact software 

utilization will have on overall system capacity) 

 Frequency of scans (the example below assumes a bi-weekly scan interval, more frequent scanning may 

require additional server capacity) 

 Amount of data collected (the examples below assume an average scan file size of ~250KB, which is 

representative of an average PC (large servers may generate considerably more data and therefore require 

additional capacity to process the data) 

 Environmental factors, such as integrations with other products, network characteristics, and 

operational requirements may impact the architecture of the DDM Inventory solution 

 The number of XML Enrichers that are running on the server 

 The settings in the virus checker installed on the server. Virus checking can add significant overhead. 

Table 1 – Suggested Hardware Requirements 

Discovered 

Devices 

Inventoried 

Devices Ports A
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o
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y
*
 

Memory 

(GB) CPU** 

Disk 

(GB) 

6,000 5,000 36,000 

 

x  1.5 

1 CPU 

2.4 GHz 25 

6,000 5,000 36,000 

 

x x   3*** 

1 CPU  

2.8 GHz 40 

  18,000 15,000 108,000 

 

x  
   2 

2 CPUs or cores 

3.0 GHz 70 

18,000 15,000 108,000 

 

x x 5 

2 CPUs or cores 

3.0 GHz 105 

60,000 50,000 150,000 

 

x  4 

2+ CPUs or cores 

3.6 GHz 200 

60,000 50,000 150,000  x x 7 2+ CPUs or cores 260 
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Discovered 

Devices 

Inventoried 

Devices Ports A
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Memory 

(GB) CPU** 

Disk 

(GB) 

3.6 GHz 

50,000 50,000 n/a x n/a n/a 2 

2 CPUs or cores 

3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 

2 CPUs or cores 

3.6 GHz 50 

* DDMI Topology is a network management component of DDM Inventory. It is no longer available for sale 

to new customers, but still available to existing Topology customers. 

** CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 

performance than those shown in the table. HP DDM Inventory consists of multiple processes, many of 

which are also multi-threaded. As a result, it benefits from Simultaneous Multi-Threading (SMT) 

technologies such as Intel® Hyper-Threading and Multi-core. 

*** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

 “Backup Scan Files” is enabled (on average, each scan file is 250KB) 

 “Delta scanning” is enabled 

 Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

 “Statistic Export” is enabled (CSV files) 

 200 users, with each user account saving 10 map configurations files 

 Space required for two backups (one stored backup, and one “in process” backup) 

Storage Requirements  

DDM Inventory is a highly I/O intensive application. High I/O performance of the disks where the data 

resides is crucial to the correct operation of DDM Inventory. Disks need to reside local to the DDM Inventory 

server or on a high performance SAN.  Network drives and clusters are not supported. Some customers have 

reported problems with SAN environments so they are not recommended.    

Benchmark your disk I/O performance prior to installing DDM Inventory for management of any large 

environment. For a medium to large DDM Inventory server deployment, minimum recommended 

throughput (as benchmarked on an idle system when the DDM Inventory server is not running) is  

70 MB/sec for read accesses and 40MB/sec for write accesses. 

Your disk space requirements may differ depending on how you are using DDM Inventory. 

 
For performance reasons, the disk where DDM Inventory data is stored should have at least 4K 

clusters. 

For the average size of scan files, refer to the “Disk Space Considerations” chapter in Installation and Initial 

Setup Guide. The inventory data collected in the scan file is stored in compressed format. For processing, the 
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data is extracted and populated into the database. In addition, if delta scanning is enabled, DDM Inventory 

keeps a copy of the original scan file as well as the enriched copy. Because of these extra disk space 

requirements, we recommend that you budget at least 5 times as much disk space for each device being 

scanned. 

 
If your average scan file size is large, adjust your disk space requirements accordingly. 

Recommended Fault Tolerance Configurations 

The recommended fault tolerance configurations are the following: 

 Raid 1 

 Raid 1+0 

DDM Inventory must be installed on a local disk. It cannot be installed on network drives, SAN drives, or 

clustered devices. DDM Inventory has been tested and can be successfully installed in a RAID (redundant 

array of independent drives) level 0 and level 1 environment.   

RAID level 0 uses a striped disk array strategy that does not provide fault tolerance. Data striping spreads 

out blocks of each file across multiple disk drives. In our test environment we use 2 drives. This 

configuration does not provide for redundancy. It improves performance but does not deliver fault tolerance. 

If one drive fails then all data in the array is lost. 

RAID level 1 uses a mirrored set strategy that provides fault tolerance from disk errors and single disk 

failure. It results in increased read performance with very small performance degradation when writing. The 

array continues to operate as long as at least one drive is functioning.  

Because it offers the best tradeoff of performance and reliability, level 1 is the recommended RAID platform 

for DDM Inventory. For large networks, level 0 can also be used if performance is more important than fault 

tolerance. RAID level 5 is not supported. 

Upgrading from Earlier Releases 

For information about upgrading from earlier releases of DDM Inventory refer to the “Upgrade and 

Migration Scenarios” chapter in the Installation and Initial Setup Guide. 
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Enhancements and Fixes 

The following items were added or fixed in the current software release. Table 2 lists enhancements to 

existing features or behavior. Table 3 lists problems that were fixed (identified by error tracking number). 

Table 2 – Enhancements 

Number Location Description 

 Scanners 

The DDM Inventory Scanner can now detect the following 

CPUs: Fujitsu SPARC64 VII+ and SPARC64 VIII; Sun 

UltraSPARC-T3; Intel Itanium 9000 Series, Itanium 9100 

Series, and Itanium 9300 Series; AMD Athlon II X3, 

Athlon II Neo, Athlon II, Six-Core Opteron, Phenom II, 

V105, V120, and V140.   

 Windows Scanner 

The Windows Server Foundation operating system can 

now be properly identified and reported as part of the 

hardware data. 

QCCR1C21145 Installer 

The DDM Inventory installer now checks to see if any 

mainstream anti-virus software is installed before the 

server installation proceeds. 

QCCR1C33002 Agent/Server 

The DDMI agent and AUM agent are now able to collect 

utilization data independently. 

QCCR1C33788 Solaris Scanner HBA cards are now detected on Solaris 10 systems. 

QCCR1C34017 Web UI 

The DDM Inventory login page can be configured to 

include a custom warning message and require users to 

confirm that they agree with the conditions before logging 

in. 

QCCR1C30657, 

QCCR1C34743 Windows Scanner 

The DDM Inventory Scanner can now read 64-bit registry 

values in 64-bit versions of Windows. For more detailed 

information, refer to the section on Asset Registry Extract 

fields in the “Scanner Generator” chapter in the 

Configuration and Customization Guide. 

 

Table 3 - Problems Fixed 

Number Location Description 

QCCR1C29618 Server 

VM names with non-English characters now display 

properly in the DDM Inventory web UI. 

QCCR1C30340, 

QCCR1C31570, 

QCCR1C33906 Windows Scanner 

The Windows scanner now collects the complete monitor 

serial number (in hwMonitorSerialNumber) for certain 

manufacturers correctly. 
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Number Location Description 

QCCR1C30414, 

QCCR1C32252 SAI Editor 

The SAI Editor ensures that the IDs of the user-defined 

files, application types, and OS types are in the valid range 

when the user SAIs are saved after being dragged and 

dropped. Therefore, the SAI Editor can now load the user 

zSAIs without displaying an error. 

 

QCCR1C31017, 

QCCR1C33092 HP-UX Scanner 

The CPU core information of various HP-UX CPUs will now 

be correctly collected. 

QCCR1C31241 

Documentation (Help-

>Database Schema) Referenced product names are up-to-date. 

QCCR1C32453 Server 

The performance of the Discovery Configuration file import 

has been improved.  

QCCR1C32478 Applets 

Event Browser is now able to display DNS names with 

illegal characters. 

QCCR1C32712 Analysis Workbench 

Analysis Workbench no longer generates an "Access 

violation" error when teaching some applications (when a 

duplicate file detail is added to the SAI). 

QCCR1C32728, 

QCCR1C33274, 

QCCR1C32454 Solaris Scanner 

The DDM Inventory Scanner now correctly collects the 

logical CPU counts in Solaris non-global zones. 

QCCR1C32752 Server 

The Discovery Engine will no longer crash in some cases 

that were caused by an agent call home request.  

QCCR1C32803 Server Users are now able to load custom map backgrounds. 

QCCR1C32807, 

QCCR1C32942, 

QCCR1C32807 Aggregator Server 

The Aggregator Server will now import data from the 

previous versions of DDM Inventory that are documented in 

the Compatibility Matrix.  

QCCR1C32809 Server 

The Discovery Engine will no longer crash in some cases 

that were caused when merging VMware inventory data 

with previously discovered network nodes.  

QCCR1C32958 Windows Agent 
The Windows agent no longer leaks Windows handles when 

running the scanning workflow. 

QCCR1C32959 Server 

Occasional memory management problems in Discovery 

Engine that could cause the module to crash in some cases 

were fixed. The logging of memory statistics over a 

configurable period (default of 5 minutes) was added (used 

memory, free, reserved, etc.). 

QCCR1C32973 Installer 

The database creation process has been improved when it is 

run on slower machines. 

QCCR1C33046 

Agent Communication 

Server Better logging is introduced when VMware discovery fails. 

QCCR1C33069 Windows Agent 

The Windows agent no longer leaks a small amount of 

memory when running the scanning workflow. This 

becomes visible only when the scanning workflow interval is 

very short, such as one hour. 
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Number Location Description 

QCCR1C33310 Solaris Scanner 

A problem with detecting the hwDiskTotalPhysicalSizeMB 

field in some cases on Solaris has been fixed.  

QCCR1C33322 Server 

The DDM Inventory server can properly display the 

"Addresses" table in the Port Manager window in Device 

Manager. 

QCCR1C33417  

Documentation (Help-

>Data Collected by 

Scanners) 

hwOSInstalledAppName was removed as a supported item 

by the Windows platform. 

QCCR1C33424 Windows Scanner 

The base OS directory (hwOSBaseDir) is now reported 

correctly for the Windows platform when the DDM 

Inventory Scanner is run inside Windows Terminal 

Services. 

QCCR1C33426 Windows Scanner 

SMBIOS data is now collected by the DDM Inventory 

Scanner. 

QCCR1C33514 XML Enricher 

Software application data from scan files is correctly 

imported into the database when the XML Enricher is 

configured to use “Installed Applications” recognition. 

QCCR1C33515 Solaris Scanner 

The DDM Inventory Scanner can now scan device files in 

Solaris 8. 

QCCR1C33555  

Documentation (Help-

>Data Collected by 

Scanners) 

Added VMware scanner platform for wOSContainerName, 

hwOSContainerID, hwOSContainerRoot, 

hwOSContainerStatus, hwOSContainerNetworkDevice, and 

hwOSContainerNetworkDeviceAddress. 

QCCR1C33591 Windows Scanner 

The DDM Inventory Scanner can now use logical CPU 

information to get the correct physical core count in a VM 

environment. 

QCCR1C33620 Server 

The Discovery Engine will no longer crash when scanning 

some types of SNMPv2c and SNMPv3 devices. 

QCCR1C33685 Server 

DDM Inventory will now add ports for every network 

adapter collected from the VMware discovery process for 

hosts. This ensures that network adapter information is not 

overridden (lost) by incomplete network discovery data. 

QCCR1C33700, 

QCCR1C33838 Solaris Scanner 

Solaris SPARC64 VII and M9000 CPUs are correctly 

identified.  

QCCR1C33742, 

QCCR1C33631, 

QCCR1C30571 XML Enricher 

The XML Enricher no longer fails to process scan files from 

Windows Domain controllers that have thousands of user 

profiles. 

QCCR1C33909, 

QCCR1C34016 Agent 

The SSL certificate/key generation configuration was 

modified to avoid the UNIX year 2038 issue. Now, SSL 

certificates/keys used for agent-based communications can 

be generated. 

QCCR1C33974 HP-UX Scanners 

More detailed information is available for Itanium CPUs 

(hwCPUFamily, hwCPUModel, and hwCPUStepping). 

Additionally, newer Itanium CPUs are identified correctly. 
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Number Location Description 

QCCR1C34214 Server 

Inconsistent port counting was fixed. This could lead to 

purging ports from SNMP-managed nodes when the 

number of active ports is near the license limit. 

QCCR1C34418 Server 

Updating the wrong node with scanned data coming from 

another node was fixed. This could happen in some rare 

cases when an IP address is reassigned from one device to 

another. 

QCCR1C34443   

Agent Communication 

Server, Standalone 

VMware Scanner 

Improved logging and error handling when users attempt to 

use vCenter to manage a host with a newer unsupported 

version of VMware. 

QCCR1C34452 Server 

DDM Inventory now only supports SSL high strength 

cipher suites; weak and medium strength cipher suites are 

no longer supported. 

QCCR1C34486 Server The Trash and Purge processes are now running properly. 

QCCR1C34712 Windows Scanner 

After you perform an upgrade of DDM Inventory, the 

Scanner is able to save the inventory file (local$.xsf) even if 

it already exists on the machine. This was not possible 

previously in some cases. 

QCCR1C34868 

Documentation (Help-

>Data Collected by 

Scanners) 

Added VMware scanner platform for 

hwOSClusterNodeName, hwOSClusterNodeState, 

hwOSClusterName, and hwOSClusterState. 

QCCR1C34981, 

QCCR1C33618 Windows Agent 
The DDM Inventory agent no longer has a memory leak in 

systems that are running Windows XP. 

QCCR1C34999 Server 

Possible memory corruption in Discovery Engine on startup 

when running on a server with multiple network adapters 

was fixed. 

QCCR1C35112 Server 

Report database tables no longer remain locked for a long 

time. 

QCCR1C35124 Scanners 

The DDM Inventory Scanner no longer incorrectly logs an 

error message when the pre-scan scripts feature is running. 

QCCR1C35135 Server 

Applications with unknown publishers are now listed in the 

“OS Registered Applications – Application Summary” 

report. 
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Known Problems, Limitations, and Workarounds  

Agents 

 When the Agent is installed on Windows Vista machines using an account other than the 

"Administrator" account, the firewall exception is not added into the exceptions list (QCCR1C382).  

 The HP-UX Agent may not work if the system name is longer than eight characters (QCCR1C35093). 

Scanners 

 In the Scanner Generator if a previously generated file is used to populate the Scanner Generator 

options and software scanning is disabled, the Scanner will still attempt to store any previously 

configured custom stored files (QCCR1C19042). 

 In some cases an unmanaged device with more than one network card may fail to run the Scanner 

because of an upload error (QCCR1C32128). 

 The DNS field in the scan file that contains the DNS entry for the primary IP may not be detected on 

some UNIX machines if a DNS server is not configured (QCCR1C32533). 

 The Linux scanner may fail and exit when run on SUSE Enterprise Desktop 9 update 4 

(QCCR1C32691). 

 There is a Container state field mismatch between the scan file and Device Manager (QCCR1C34856). 

Analysis Workbench 

 In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the “Treat field as 

a File Name‟‟ option is selected, the “Replace invalid characters with‟‟ field must be populated as well, 

even if the “Delete invalid characters‟‟ option is selected instead.  Otherwise, the “The file „Replace 

invalid characters with‟ may not be empty” error dialog appears (QCCR1C1275). 

 For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 

structure in AW (QCCR1C1480). 

 The Analysis Workbench sample script does not run on Windows 2008 because the default directories 

are not set correctly. The script works properly on all other supported platforms (QCCR1C19475). 

 The save state feature does not work in Windows 2008 or in Windows Vista (QCCR1C35035). 

Server Installation 

 After uninstalling, the branding registry keys are left over (QCCR1C1434).  

 Non-ASCII characters used in data directory path name can cause problems during the installation 

(QCCR1C16520 and QCCR1C1472). 

 When uninstalling DDM Inventory on a small server, the uninstaller may not be able to stop the 

database. It may take several tries to uninstall the software (QCCR1C2405). 

 DDM Inventory with a Network Topology license should not be installed on VMware (QCCR1C5271). 

 The SNMP extension registry key may not be removed on some Windows 2008 server installations 

(QCCR1C29306). 
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 After a new installation, opening the SAI Editor for the first time may show a warning message 

(QCCR1C32445). 

 If DDM Inventory is upgraded from a previous version, the certificate date may not be updated 

(QCCR1C32481). 

 When installing DDM Inventory on Windows Server 2003 SP2, you may receive a digital signature 

policy error. 

 If the Windows SNMP service is not installed and enabled, during the installation phase, the DDM 

Inventory server installs and configures the Windows SNMP service to run. This is because the DDM 

Inventory server requires it for its own operation. However, the default security settings are used for the 

Windows SNMP service, such as the read community string being set to public. Please follow these 

instructions to change the default security configuration of the SNMP service with custom settings as 

needed: 

o Open the Services Control Panel applet: Control Panel > Administrative Tools > Services 

o Right-click SNMP Service, select Properties, and then navigate to the Security tab. 

o Amend the security settings as required. 

Once the default read community string is changed, please update the appropriate DDM Inventory 

SNMP profiles by adding this read community string to make sure that DDM Inventory can still access 

the SNMP information from the DDM Inventory server itself. 

Server 

 In some cases, the ID assigned to the auto.zsai and the user.zsai files may be the same. This 

results in the inability to load both files into the client tools at the same time (QCCR1C4448). 

 Older OpenSSL DLLs in the system PATH can affect the DDM Inventory Apache server and Perl 

engines (QCCR1C5447). 

 If your server has another service using port 80, the HP Discovery Apache service will not run properly. 

As a workaround, you can comment out the “Listen 80‟‟ directive in the httpdf.conf file 

(QCCR1C6670). 

 If there is a MySQL query that takes too long, DDM Inventory will not function properly and you may 

need to restart System Monitor to recover (QCCR1C7409). 

 If two or more VMware virtual machines configured on the same host share the same IP address 

(possible if a virtual network adapter is disabled), VMware discovery may yield incorrect IP address 

information for a virtual machine. This can happen as VMware discovery does not currently detect 

whether a network adapter is disabled (QCCR1C19379). 

 Sometimes when logging into the DDM Inventory server, a pop-up window opens with the message 

“Jscript compilation error: Expected „}‟”.  This problem occurs as a result of calling Java Applets from 

Internet Explorer (this issue does not seem to occur with Firefox). The problem is not specific to DDM 

Inventory and can be seen on various Web pages where Applets are present. Note that the pop-up 

window opens with this message only if the “Disable script debugging” option is enabled. Otherwise, if 

this option is enabled, only a warning icon (yellow triangle containing an exclamation mark) will appear 

on the left-side of the Internet Explorer taskbar when this problem occurs. This problem has occurred on 

both Internet Explorer version 6 and version 7 (QCCR1C19591). 

 If a non administrative user logs into the Windows server, an error indicating that the syspanel.log 

file cannot be created may occur (QCCR1C20437). 

 If agent and agentless scanning is enabled for a property group, in some cases installing and then 

uninstalling an agent may result in DDM Inventory not recognizing that a device has an agent on it 

(QCCR1C29364). 
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System Panel 

 When there are multiple instances of the DDM Inventory System Panel running on the Server, only one 

of the System Panel instances will display Port Usage information (QCCR1C20409). 

Web User Interface 

 After an agentless scan (using SSH) has successfully been run, the account used for this connection 

cannot be changed unless the account from the DDM Inventory UI is deleted (QCCR1C19398). 

 The hyperlink (5
th
 token) in the breadcrumb is missing for some reports (QCCR1C35014). 

Applets 

 When upgrading, the applet may not recognize a new license until the server has been restarted 

(QCCR1C32483). 

Administration 

 Depending on the licenses, the “Resource/ Environment manage‟‟ option in Discovery Configuration may 

not have any effect (QCCR1C7034). 

 In the Service Analyzer, device breaks may show up in the filter list for line breaks (QCCR1C18988). 

 If the recognition type is set to Installed Applications, the auto.zsai file will not be created 

automatically (QCCR1C30353). 

Web Asset Questionnaire 

 In Internet Explorer, when connecting to the main page through a proxy server, the “You are connecting 

from‟‟ IP address reported will be the IP address of the proxy server, and not that of the remote computer 

address (QCCR1C764). 

 The UI may show non-printable characters in text fields (QCCR1C2408). 

Reports 

 The Alarm summary of Collisions, Frame Relay FECN/BECN, DE Inventory reports and Device Load 

Average may report N\A instead of the correct values (QCCR1C29312). 

Licensing 

Alarms License  

 Alarm-related items are not always hidden (QCCR1C5673). 

Internationalization 

 Various UI screens (reports, status reports, Device Manager, and so on) format the “day of the month‟‟ 

part of the date as Arabic numerals instead of using the language option configured by the operating 

system (QCCR1C416). 
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 When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 

Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 

information (QCCR1C490). 

 There are several problems with the SAI Editor accepting characters in the Korean code page 

(QCCR1C507, QCCR1C508). 

 The statistics graphs do not use the language options configured in the operation system and will always 

format the dates in English (QCCR1C2043). 

 SAI files with non-English names may appear incorrect when viewing them with the DDM Inventory 

web user interface (QCCR1C19372). 

 If the name of a User zSAI file contains non-English characters, the XML Enricher may not be able to 

load that zSAI file (QCCR1C19402). 

 Recognition rules written in non-English characters may not recognize all versions (QCCR1C19610). 

 Some non-English locales may not report the total disk space correctly in some cases (QCCR1C19614). 
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